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P A R T  I

Welcome to

ToolBook Assistant

This part of the ToolBook Assistant User Guide describes how to set up and
install ToolBook Assistant,™ introduces basic ToolBook™ concepts, and
explores the user interface.

IN THIS PART

Chapter 1 Getting started

Chapter 2 Basic concepts

Chapter 3 Learning the Assistant interface
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Getting started

Welcome to ToolBook Assistant—the easiest way to create online
learning applications. In this book, you’ll learn about the basic
concepts and tools you need to build and manage complete,
effective courseware. You’ll also learn how to add interactive
functionality to your application using predefined objects with
extended capabilities that you can customize.

Before you go on to explore Assistant, read through this chapter.
Here you’ll learn how to install and start Assistant, find out about
the resources available to help you learn Assistant, and preview
this book’s contents and conventions.

IN THIS CHAPTER

Introducing ToolBook Assistant 14

Before you install 15

Installing Assistant 18

Starting and exiting Assistant 19

Learning Assistant 20

About this book 24
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Introducing ToolBook Assistant

ToolBook Assistant is a complete courseware authoring system that
allows you to create and distribute online learning applications—without
programming.

With Assistant, you can focus on what is important: presenting the
material to be learned. Assistant helps you create and manage the
content, navigation, feedback, and quizzes that are a vital part of your
interactive learning applications. You can easily add sound, animation,
video, graphics, and other special effects to your applications, making
them lively and engaging. Hyperlinks and navigation objects allow your
learners to control the direction and pace of their learning experience.

After you have created a course using Assistant, you can deliver it on
demand to any student with access to the Internet, or you can deploy it
on your company’s intranet. Assistant offers several flexible deployment
options. Your students can view your course in a Web browser after you
use the Web Specialist to convert your course to a series of HTML files.
Students can also use the ToolBook Neuron browser plug-in to view
your course as a native ToolBook book (TBK file). You can also distribute
your course as a run-time (stand-alone) application that will run from a
hard disk drive or CD-ROM.
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Before you install

Before installing ToolBook Assistant, take a moment to check your
package contents to make sure you received everything.

In addition to this book, the full retail version of Assistant should
contain:

◆ a program disc with the ToolBook Assistant program and a variety of
online resources.

◆ a software license agreement.

System requirements

To run ToolBook Assistant, your computer configuration must meet the
minimum requirements outlined in the table on the following page.

Note If you plan to create interactive courseware with a lot of

graphics, video, and text, your system will run more efficiently if

it has at least the recommended components.
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Minimum and recommended system configurations

Component Minimum Recommended

Computer Pentium® 233 Pentium III 500 or higher

RAM (random 64 megabytes (MB) for 256 MB or more
access memory) playback; 128 MB for authoring

CD-ROM drive Single-speed Double-speed or faster

Hard disk 150 MB* Up to 310 MB for all
space optional components

Operating Microsoft® Windows® XP† Same as minimum
system Professional or Home Edition,

Windows 2000 Professional†

Service Pack 3 or later,
Windows Millennium Edition,
Windows 98 Second Edition

Sound card Optional Windows-compatible

Graphics card Graphics card capable of Graphics card capable of
displaying 800 x 600 resolution displaying 1024 x 728
with 16-bit color pixel resolution with
(65,536 colors) 16-bit color or higher
for authoring (65,536 colors)

* Depending on the options chosen during setup, your installation might require more space.
† You must have an administrator account on Windows 2000 and Windows XP in order to install

Assistant. See your system administrator or refer to your Windows documentation for details.
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Additional multimedia requirements

You can add media to courseware in a variety of ways. Most computers
come with the hardware and software components necessary for
developing or using multimedia programs. Depending on how you plan
to use media in your courseware, you will need some or all of the
following items:

◆ A sound card to play digital audio files

◆ Speakers or headphones to play audio

◆ Files required to play digital video files, such as video playback
drivers

◆ Additional files required to play media or other content on the
Internet (for example, browser plug-ins like RealMedia™ and
ToolBook Neuron)

Note You don’t need to be a video technician or graphic artist

to create compelling courseware for education and training.

Many companies now sell images, video clips, and sounds that

you can copy into your multimedia application. Usually, the

purchase of a company’s product that contains media files

gives you the right to publish them in your application. Some-

times, however, you must agree to specific licensing require-

ments. Never assume that you have rights to publish media

files; always read the product’s documentation. When in doubt,

consult the product’s manufacturer.
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Installing Assistant

To install Assistant and its associated files, use the Setup program,
which provides options and instructions for each step. The Setup pro-
gram decompresses the files and transfers them to your hard disk.

The Setup program is set to run automatically when you insert the
Assistant program disc into your CD-ROM drive. You can also manually
install Assistant, as described below.

➤➤➤➤➤ To manually install Assistant:

1 Insert the Assistant program disc into your CD-ROM drive.

2 If the Setup program does not start automatically, from the Start
menu, choose Run.

3 In the Run dialog box, type the location from which you are installing
Assistant, plus the word setup (for example, type d:\setup). If your
CD-ROM drive letter is not d, substitute the letter of the drive contain-
ing your program disc.

4 Click OK, and then follow the instructions on the screen.

5 After installation is complete, you may be prompted to restart Win-
dows.



Chapter 1 Getting started 19

Starting and exiting Assistant

You start and exit Assistant as you would any Windows application.

➤➤➤➤➤ To start Assistant:

◆ From the Start menu, point to Programs, point to ToolBook, point to
Assistant 2004, and then choose ToolBook Assistant.

When you start Assistant, the ToolBook Assistant Startup dialog box
appears. Use this tabbed dialog box to start a new book or open an
existing book. You can also access the online Welcome Tour from this
dialog box.

Figure 1

ToolBook Assistant Startup dialog box
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➤➤➤➤➤ To exit Assistant:

◆ From the File menu, choose Exit; alternatively, click the Close button
on the title bar.

Learning Assistant

Assistant includes both online and printed documentation, as well
as a number of other resources to help you learn to use Assistant.
Further assistance is available from the SumTotal Systems technical
support staff.

You’ll find the following online resources on the Welcome tab of the
ToolBook Assistant Startup dialog box, which appears when you start
Assistant:

◆ The Welcome Tour highlights the unique authoring features you’ll use
to create online learning applications in Assistant.

◆ The Quick Start application will help you to become comfortable using
Assistant’s authoring tools.

In addition, the Assistant documentation set includes an online version
of this book available from the Start button on the Windows taskbar. To
access this online book, click the Start button, point to Programs, point
to ToolBook, point to Assistant 2004, point to Documentation. In the
online versionof this book, you can quickly search for any word or
phrase in the PDF file.

A variety of other learning resources are discussed in the sections
that follow.
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Using the online Help system

The online Help system is a fast, comprehensive information resource
about how to use Assistant. Here, you’ll find information on specific
dialog boxes, maps of screen elements, keyboard and mouse shortcuts,
and information about what’s new in Assistant. There are several ways
to access online Help:

◆ From the Help menu, choose Help Contents. Then, find the information
you need by choosing from the many Help categories and topics.

◆ Open a context-sensitive Help topic in a dialog box by pressing the
F1 key or by clicking the Help button.

◆ Search on keywords by choosing Search for Help On from the
Help menu.

◆ Display tooltips on the screen by pausing the pointer over a button on
any toolbar.

Using the ToolBook Coach

The ToolBook Coach is a quick, convenient reference tool that provides
context-sensitive information as you’re authoring. The Coach displays
design guidance, tips, and suggestions about the page you’re working
on, and step-by-step procedures for any object you select. Leave the
Coach open as you work and note how the information in the Coach
window changes dynamically according to the object and page you’re
working with.
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➤➤➤➤➤ To open the Coach:

◆ From the Help menu, choose Coach.

Figure 2

The ToolBook Coach

Accessing release notes and other files

The release notes are written as the software is completed to ensure
that you get the latest possible information about the product. The notes
cover exceptions and last-minute information. The notes also provide
information on product compatibility, as well as on converting from
earlier versions of the product. The release notes are installed along
with Assistant and can be accessed from the Welcome tab in the Startup
dialog box. Also, the release notes are also available on the Assistant
program disc.
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Visiting the SumTotal Systems Web site

You’ll find a variety of information on the SumTotal Systems Web site.
Here you’ll find online technical information and support, see examples
of products created with our software, and learn about the many easy
solutions SumTotal Systems provides for authoring. Here are some of the
items from among the many great features you’ll find at
http://www.sumtotalsystems.com:

◆ Access to the Knowledge Base, a database of product information
where you can perform keyword searches for articles

◆ Access to files that you can download, including sample applications,
plug-ins, and updates of current applications, as well as a link to the
SumTotal Systems FTP (File Transfer Protocol) site

◆ Telephone numbers for technical support staff

◆ Tips on how best to use SumTotal products, with creative and diverse
examples provided by customers

Contacting SumTotal Systems for technical
support

If you have questions that cannot be answered by the Assistant
documentation, online Help, or the online resources available from the
SumTotal Systems Web site, you can contact technical support representa-
tives at SumTotal Systems. Refer to the topic “Technical Support” in
online Help or see the Telephone Support information on the SumTotal
Systems Web site.
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About this book

This book has several parts that describe different aspects of building
an interactive online learning application with Assistant.

Part 1, “Welcome to ToolBook Assistant,” discusses basic Assistant
concepts and describes the user interface.

Part 2, “Building your application,” includes concepts and techniques
to help you construct and customize your online learning courses.

Part 3, “Adding interactive features to your application,” describes
how to use built-in Assistant features that add interactivity to your
application to help you engage your learners.

Part 4, “Distributing your application,” describes how to prepare and
package a course for distribution to your audience.

A glossary and an index are also included in this book.
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Document conventions

This book uses the following visual conventions to help you identify and
interpret information.

Document conventions

Example format Meaning

Setup In step-by-step procedures, italic type indicates literal
characters to type.

CTRL+ALT+DEL Keys separated by a plus sign indicate keys to press in
combination.

This icon appears by text that indicates where to look
in online Help for more information.
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C h a p t e r  2

Basic concepts

This chapter provides an overview of ToolBook Assistant and
explains important concepts you should understand in order to
use Assistant successfully.

IN THIS CHAPTER

About the ToolBook product family 28

About ToolBook Assistant 29

Planning your project 30

Building an application 34
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About the ToolBook product family

ToolBook Assistant is one of many products offered by SumTotal Systems
to help you author, manage, distribute, and access interactive online
learning applications. Below is a description of some SumTotal Systems
software tools. For more information about products and services from
SumTotal Systems, visit our Web site: http://www.sumtotalsystems.com.

◆ ToolBook Assistant Designed for ease of use, Assistant includes a rich
set of basic draw objects, graphics, and predefined objects with extended
capabilities. Its intuitive interface is ideal for those who want to create
interactive learning applications quickly—without programming.

◆ ToolBook Instructor™ Designed for the flexible creation of interactive
applications, Instructor includes the ability to fully customize your
application. Instructor offers a full-featured development environment
for creating sophisticated courseware that you can easily deliver over
the Internet, an intranet, or on CD-ROM. Its wide array of tools includes
the Actions Editor for creating functionality that will automatically
convert to DHTML. For specialized needs, Instructor includes the
powerful OpenScript programming language for preparing simulations,
utilizing ActiveX controls, and creating other types of object behavior.

◆ ToolBook Neuron Available as a browser plug-in or ActiveX® control,
Neuron allows you to access and run native ToolBook Assistant and
Instructor applications in the Netscape Navigator® and Microsoft Internet
Explorer™ browsers. You can optimize the performance of your native
ToolBook applications using Impulse for Neuron, a postprocess utility
that segments your book to allow rapid data transfer over the Internet—
greatly enhancing the speed of delivery.
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About ToolBook Assistant

Assistant is a courseware authoring program that allows content ex-
perts, business professionals, and educators to create, customize, and
deliver online learning applications. With Assistant, you don’t need to
learn how to program: You can create a book using a template and then
fill the prebuilt pages with your own content. A template provides the
basic appearance and outline for your book. You can thoroughly cus-
tomize a template by adding objects from the Catalog.

Figure 1

The Assistant Catalog

The Catalog contains objects with predefined capabilities that handle
everything from page navigation and quiz scoring to special effects like
multimedia feedback and animation. These objects provide prebuilt
functionality for the majority of your authoring tasks.
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When you have finished authoring, you can distribute the application
you created in several ways—using the Internet or an intranet, a local
area network, or a CD-ROM. Assistant prepares your files according to
the distribution method you choose.

Exploring the kinds of applications
you can create with Assistant

Assistant has specially designed features that allow you to create
online courses for training and education environments. You can create
a variety of courses with Assistant, including guided tours, interactive
presentations, demonstrations, and tutorials, to name just a few. But
you’re not limited to courseware development. With Assistant’s flexible
and versatile authoring environment, you also can create online
presentations, kiosk applications, catalogs, and games. The blueprint
for your Assistant application resides in your own imagination. 

Interactive online learning applications

An interactive online learning application provides computer-based
instruction that responds to a student’s actions. You can create an
Assistant application that not only presents information, but also quizzes
students and stores their responses, displays hints, acknowledges correct
answers, and tracks progress from lesson to lesson.

Planning your project

Project planning is a preliminary step in which you evaluate your goals
and resources, decide on your distribution strategy, develop a user
profile and then document your research and choices. These decisions
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are part of a project plan, which typically contains the following sections:

◆ PurposePurposePurposePurposePurpose  Answer the question, “Why is this e-learning course needed?”

◆ Resource listResource listResource listResource listResource list  Describe the resources you have and/or need for this
project, including people, tools, budget, and time.

◆ User profileUser profileUser profileUser profileUser profile  Describe the target audience. Gather information about
the level of experience and education the audience may have.

◆ Learning objectivesLearning objectivesLearning objectivesLearning objectivesLearning objectives  Develop learning objectives for each topic and the
course as a whole. Include the conditions under which the learner will
complete the assignments and the standard for evaluating individual
performance on tests and quizzes.

◆ Instructional approachInstructional approachInstructional approachInstructional approachInstructional approach  Decide on the teaching model that best suits
the audience. You can combine interactive, collaborative, and self-
paced features.

◆ Content outlineContent outlineContent outlineContent outlineContent outline  Prepare an outline which describes the main topics
and subtopics, quizzes, overviews, and summaries.

◆ Layout designLayout designLayout designLayout designLayout design  Create a custom design for pages or choose from
templates provided in ToolBook Assistant.

◆ Evaluation strategyEvaluation strategyEvaluation strategyEvaluation strategyEvaluation strategy  Develop a plan to test and evaluate the course
before distribution.

◆ Schedule for developmentSchedule for developmentSchedule for developmentSchedule for developmentSchedule for development  Build a timeline that shows the time
designated for planning, content development, graphic design, reviews,
testing, and production.

Creating an organized directory structure

Whether you plan to build just one online learning application or several,
you’ll find it helpful to organize your files. In addition, when you prepare
your application for release, you’ll want to keep track of any ancillary
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files that need to be distributed along with your application.

As we’ll discuss later in this chapter, applications created in Assistant are
composed of one or more files called books. These books should reside
in one central book directory, with one or more subdirectories for the
media (sound, graphics, video, and animation) files that accompany
those books.

Let’s say your application has just one book—Introduction to French. We
suggest the following directory structure:

\French
IntroFrench.tbk (the ToolBook book)
\French media

EiffelTower.avi (a video file)

To organize a project which includes multiple books, you can create a
single project folder and add subdirectories to store related books.

Deciding how you
will deliver your course

Perhaps the most important decision you’ll need to make before begin-
ning an application is how you will deliver your course to your learners:
using the Internet or an intranet, a local area network, or a CD-ROM.
Because each delivery method may require different preparation, you will
want to decide this early in your project development.

The table on the following page provides a brief overview of application-
delivery options and requirements to consider for each method. Chapter
14, “Preparing applications for release,” covers these issues in greater
detail. You may want to review this chapter before you begin your project
so that you are prepared for some of the requirements you’ll meet later
on.
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Prepare your project for release
based on a method of distribution

Distribution method Platform required Preparation guidelines

Via the Internet or intranet Microsoft Internet Use the ToolBook Web
as a series of Web pages Explorer 5.5 SP 1 Specialist to automatically
that incorporate DHTML or later, Netscape export your application to

Navigator 7.1 Web pages.

Via the Internet or intranet Windows 98, Use the ToolBook Web
as a native ToolBook Windows ME, Specialist to prepare
application displayed in a Windows 2000, your application. Ensure
Web browser using the Windows XP (or later) that users have (or can
ToolBook Neuron plug-in operating system; download) the Neuron

Internet Explorer 4.0 browser plug-in.
(or later) or Netscape
Navigator 4.0
(or later)

Via a local area network Windows 98, If users will install the
as a native ToolBook Windows ME, application on their own
application Windows 2000, computers, use the

Windows XP, ToolBook AutoPackager
(or later) to create a setup program.
operating system

Via CD-ROM Windows 98, Use the ToolBook
or other transferable Windows ME, AutoPackager to create
media Windows 2000, a setup program.

Windows XP,
(or later)
operating system
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Building an application

You build an application in Assistant by starting a book and adding your
content: text, interactive objects, graphics, navigation, and so on. You
can control the appearance and behavior of books, pages, and objects by
setting properties. You create applications at Author level; users interact
with them at Reader level.

Author level and Reader level

Assistant has two levels of operation: Author level and Reader level. At
Author level, you create and modify applications using authoring and
development tools such as templates, the Catalog, and dialog boxes. At
this level, you can create and modify objects and set properties to define
their appearance and behavior.

Reader level is the level at which you test your applications as you
develop them, and also the level at which users run your applications.
At this level, users can navigate to particular pages, type text into fields,
respond to interactive question objects, and trigger events.

For more information about Author level and Reader level, see Chapter 3,
“Learning the Assistant interface.”
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Author level

Reader level

Additional reading

Additional reading

Figure 2

Author and Reader levels in Assistant
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Books and pages

An online learning application created with Assistant consists of one or
more files called books. Books can be ordered so that they represent a
sequenced course, or they can be joined by context-sensitive hyperlinks
that your users access on an as-needed basis; for example, one book may
be a glossary for another book in your course.

In your online book, each screen is considered a separate page. Pages
contain the elements that determine the look and behavior of your
application—buttons, graphics, text, media players, and so on. You
arrange the pages in any order that suits your material and then determine
a way for your users to navigate through the pages.

A background is the foundation for a page. Several pages can share one
background, and a book can contain many backgrounds. Placing elements
on the background allows you to maintain a consistent layout throughout
your book.
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Background Pages that share a background

Figure 3

Books consist of pages and backgrounds
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Objects and properties

All of the visual elements of your application—buttons, text, graphics,
and even pages and backgrounds—are objects. Each object has a set
of properties that define its appearance and behavior. A text field, for
example, has properties such as fill color, width, and height that determine
its color and size, and other properties such as text alignment and field
type that define how it displays text and whether it allows users to enter
data. Some objects have properties that determine more sophisticated
capabilities. A media player, for example, has properties that control the
player’s interactive functionality, such as which media file will play and
how Assistant will play the file at Reader level.



Chapter 2 Basic concepts 39

Properties for Tex
Field dialog box

Figure 4

A text field and its Properties dialog box

You set an object’s properties using the Properties dialog box. Objects
from the Catalog that include preprogrammed behavior, such as answers
to a multiple-choice question, also have an Extended Properties dialog
box. For more information about setting properties, see Chapter 7, “Setting
object properties.”
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C h a p t e r  3

Learning the Assistant interface

This chapter helps acquaint you with the ToolBook Assistant
visual interface. Here you will learn about each interface component,
how to customize the interface, and how to use built-in tools to
navigate in Assistant applications.

IN THIS CHAPTER

Introducing the visual interface 42

Working at Author level 44

Working at Reader level 58

Navigating in an application 59
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Introducing the visual interface

Designed for ease of use, the ToolBook Assistant tools and visual
interface let you focus on the important tasks of presenting your content
and measuring student results. Assistant has two working levels: Author
level and Reader level. At Author level, you build applications using
development tools, such as the Catalog and the toolbar. With these tools,
you can build books, create and modify objects on pages, and add
interactive behavior to your application.

At Reader level, you can test your application to see how it will appear
to your users. Users will run your application at Reader level, where they
can navigate to pages, respond to question objects, and trigger events. To
switch between Author level and Reader level, press F3 or choose Author
or Reader from the View menu.
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Author level Reader level

Figure 1

Author and Reader levels in Assistant
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Working at Author level

When you first start Assistant, you see the Author-level workspace. At
Author level, you use tools such as the menu bar, toolbar, status bar, and
Catalog to help you build your application.

Menu bar
Toolbar

Rulers

Grid

Status bar

Catalog

Figure 2

Author-level tools
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The following tools are available at Author level:

◆ Menu bar Allows you to execute commands and access dialog boxes.

◆ Toolbar Provides a collection of buttons that you can use as shortcuts
for commonly used menu commands, displays information about
Assistant objects, and provides tools that you can use to navigate
between pages.

◆ Status bar Shows you the name of objects, menu-item Help text, and
the current mouse position. The right side of the bar provides a quick
way to select the current page.

◆ Catalog Contains navigation panels, question objects, media players,
and other objects that you can use to design applications.

◆ ToolBook Coach Provides step-by-step instructions and a brief
explanation of the object currently selected.

◆ Rulers Show you the exact size and position of objects.

◆ Grid Displays a matrix of dots that helps you size and position objects
precisely.

◆ Right-click menus Appear when you right-click an object, providing
quick access to common settings and dialog boxes.
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Working with the toolbar

The toolbar provides quick access to common menu commands, editing
tools, and authoring information. For example, you can click the Open
button on the toolbar instead of choosing Open from the File menu.

A command button

Page navigation features

Current Selection box

Extended Properties button

Figure 3

The toolbar at Author level

The Assistant toolbar contains the following elements:

◆ Command buttons Provide shortcuts to common menu commands
and authoring tasks. Click a button to activate the command, as
described in the table on the following page.

◆ Page navigation features Consist of the Page Navigation box, which
displays the page number of the current page, and navigation buttons,
which you can click to move to the next or previous page. To go to a
specific page, click the Page Navigation box, type the number or name
of the page you want, and click OK.

◆ Current Selection box Shows you which object or objects are selected.
Click the Current Selection box to quickly switch from text- or group-
editing     mode to object-selection mode.
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Toolbar command buttons and their function

Use this button... If you want to...

Open Book Open another ToolBook book.

Save Book Save your book.

New Page Name a new page and add it to your book.

Catalog Open or close the Catalog.

Font Choose the font in which text appears. If you have not high-
lighted text or selected a text field, clicking this button allows
you to set the default font for the book.

Stroke Color Choose a stroke color for the selected object. If no object is
selected, clicking this button allows you to set the default stroke
color for the book.

Fill Color Choose a fill color for the selected object. If no object is selected,
clicking this button allows you to set the default fill color for
the book.

Properties Open the Properties dialog box for an object. The tooltip that
appears when the pointer is paused over this button changes
dynamically according to the object selected; likewise, the dialog
box that opens displays settings for the object selected and will
change when a different object is selected (the object selected is
identified in the title bar). If no object is selected, clicking this
button opens the Properties for New Objects dialog box, where
you can specify default settings for any new objects.

Extended Open the Extended Properties dialog box for an object. The tooltip
Properties that appears when the pointer is paused over this button changes

dynamically according to the object selected. This button is
available only when you select an object with extended properties;
otherwise, it appears dimmed.
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➤➤➤➤➤ To hide and show the toolbar:

◆ From the View menu, choose Toolbar.

Working with the status bar

The status bar, which displays information about Assistant and the
current page, has several parts:

◆ Caption area Displays menu-item Help text or the name of an object,
depending on what the mouse is pointing to. Assistant also displays
progress messages in the caption area when a process is under way.

◆ Mouse position indicator Displays the coordinates of the cursor in
page units.

◆ Page selection indicator Shows that you have selected a page.
Assistant removes the page selection indicator from the status bar
when you are working on the background.

Page selection indicator

Mouse position indicatorCaption area

Figure 4

The status bar at Author level
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Working with the Catalog

The Catalog contains the authoring objects you use to build your
interactive online learning application. In the Catalog, there are question
sets, media players, navigation panels, and other interactive objects,
many with predefined behavior that you can customize. To include an
object in your application, you simply drag it from the Catalog to your
page or background. Then, set its properties or extended properties to
further define its appearance and behavior.

Figure 5

The Catalog
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➤➤➤➤➤ To display the Catalog:

There are three ways to display the Catalog.

◆ From the View menu, choose Catalog.

◆ Click the Catalog button on the Assistant toolbar.

◆ Press F2.

For more information about using Catalog objects to build an applica-
tion, see Chapter 5, “Working with the Catalog.”

Working with the Properties
and Extended Properties dialog boxes

After you add an object to the page, you set its properties to customize
its appearance and behavior in your application. You set an object’s
properties by first selecting the object and then opening the object’s
Properties or Extended Properties dialog box. These dialog boxes allow
you to set an object’s color, specify a graphic displayed on a button,
identify the correct answers in a question object, control when a video
plays, and much more.

You can also use the Properties dialog box to specify behavior that
extends beyond individual objects. For example, you can set properties
for a page, a background, and a book. Assistant also provides a Properties
for Lesson dialog box, where you can set scoring and logging options.
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➤➤➤➤➤ To display the Properties dialog box:

There are four ways to display the Properties dialog box.

◆ From the Object menu, choose one of the properties options. (For
example, if a button is selected, choose Properties for Button.)

◆ Click the Properties button on the Assistant toolbar.

◆ Right-click an object, and then select the properties option from the
right-click menu.

◆ Press SHIFT+F6.

Working with the Properties dialog box

The Properties dialog box features tabs that organize a detailed set of
options. The toolbar in the Properties dialog box includes buttons to give
you quick access to commands, other object properties, and online Help.
For example, if you make a mistake, you can click the Undo button to
reverse the changes you made.

Tip For convenience, you can leave the Properties dialog box open

as you work—the Properties dialog box shows you the properties of

the currently selected object. This allows you to quickly set the

properties of different objects on your page without having to close

and reopen a dialog box several times.
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Figure 6

The Properties dialog box

Working with the Extended Properties dialog box

Many objects from the Catalog have extended properties that define their
preprogrammed behavior. In addition to the Properties dialog box, these
objects have an Extended Properties dialog box, where you can specify
and refine these extended capabilities.
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➤➤➤➤➤ To display an object’s Extended Properties dialog box:

There are five ways to display the Extended Properties dialog box.

◆ With the object selected, from the Object menu, choose the extended
properties command. (For example, if an action trigger is selected,
choose Properties for Action Trigger.)

◆ With the object selected, click the Extended Properties button on the
Assistant toolbar.

◆ In the object’s Properties dialog box, click the Extended Properties
button on the dialog box toolbar.

◆ Right-click the object, and then choose the extended properties
command from the right-click menu.

◆ With the object selected, press CTRL+F6.

For more information about setting object properties, see Chapter 7,
“Setting object properties.”

Working with rulers and the grid

You can use the rulers and the grid to help you precisely size and align
objects. The rulers appear along the top and left edges of the main
window unless you hide them to make more room in the window. As you
move the cursor inside the window, a line appears in each ruler indicating
the position of the cursor. If you select an object, shadows in the rulers
indicate the object’s dimensions.
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Shadow
area

Ruler

Figure 7

The rulers in the main window

➤➤➤➤➤ To hide or show the rulers:

◆ From the View menu, choose Rulers.

By default, Assistant displays the rulers using the units of measurement
specified in Windows. You can change the units of measurement within
Assistant in the Grid dialog box.



Chapter 3 Learning the Assistant interface 55

The grid is a matrix of dots spaced an equal distance apart in the main
window. You can specify that Assistant align objects with the grid auto-
matically when you move or resize them. The grid does not have to be
visible for you to snap objects to it.

Grid dots

Figure 8

The grid in the main window

You can show and hide the grid as needed at Author level; however, even
if the grid is visible at Author level, it never appears at Reader level. You
can set the grid spacing to any width you want.




